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About This Guide

This document contains information on the following:

+ Chapter 1, “Overview,” on page 7

+ Chapter 2, “Accessing the SecureLogin Client Utility,” on page 11
+ Chapter 3, “Automating Logging In to Applications,” on page 13
+ Chapter 4, “Creating Login Credentials,” on page 27

+ Chapter 5, “Changing Preferences,” on page 31

+ Chapter 6, “Managing Your Passwords,” on page 41

+ Chapter 7, “Managing Information Cache,” on page 47

+ Chapter 8, “Managing the Passphrase,” on page 53

Additional Documentation

For the latest version of SecureLogin guides, see www.netig.com/documentation/securelogin/

Contacting Sales Support

For questions about products, pricing, and capabilities, contact your local partner. If you cannot
contact your partner, contact our Sales Support team.

Worldwide: www.netig.com/about_netig/officelocations.asp
United States and Canada: 1-888-323-6768
Email: info@netig.com
Web Site: www.netig.com

Contacting Technical Support

For specific product issues, contact our Technical Support team.

Worldwide: www.netiq.com/support/contactinfo.asp
North and South America: 1-713-418-5555

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netig.com

Web Site: www.netig.com/support
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Contacting Documentation Support

Our goal is to provide documentation that meets your needs. If you have suggestions for
improvements, click Add Comment at the bottom of any page in the HTML versions of the
documentation posted at www.netig.com/documentation. You can also email Documentation-
Feedback@netiq.com. We value your input and look forward to hearing from you.

Contacting the Online User Community

Qmunity, the NetlQ online community, is a collaborative network connecting you to your peers and
NetlQ experts. By providing more immediate information, useful links to helpful resources, and
access to NetlQ experts, Qmunity helps ensure you are mastering the knowledge you need to realize
the full potential of IT investments upon which you rely. For more information, visit http://
community.netiq.com.
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Overview

SecureLogin is a Single Sign-on (SSO) product. It eliminates the necessity for users to remember
multiple usernames and passwords. It stores usernames and passwords and automatically retrieves
them for users when required.

SecureLogin consists of multiple, integrated security systems that provide authentication and single
sign-on to networks and applications.

SecurelLogin has wizards, an iManager plug-in, and tools that make it easy to centrally configure for
use on the corporate network.

It supports usernames, passwords, and multi-factor authentication such as smart cards, tokens, or
biometrics at the network and application levels.

In this document, we take a menu-oriented approach in explaining how to use the SecureLogin Client
Utility to customize SecureLogin to your preferences and requirements.

Management Utilities

SecurelLogin has two management utilities:

+ “Administrative Manage Utilities” on page 7
+ “The SecurelLogin Client Utility” on page 9

Administrative Manage Utilities

Administrators use the Administrative Management utilities: iManager SSO plug-in, SecurelLogin
Manager, and Active Directory Computer Users and Snap Ins to define the settings and preferences
of SecureLogin for use by the end users.

Overview
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Figure 1-1 iManager: One of the Administrative Management Utilities
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Figure 1-2 The SecureLogin Management
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The SecureLogin Client Utility

You can use the SecureLogin Client Utility to customize the SecureLogin to suit your requirements.
For example, you can set your own passphrase question and answer, and set your own password
policies.
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Figure 1-3 The SecureLogin Client Utility
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Accessing the SecureLogin Client Utility

The SecureLogin Client Utility is represented by an icon in the notification area (system tray).
To launch SecurelLogin:

1 Click Start > Programs > SecureLogin.

After you successfully launch the SecurelLogin, the appears in the notification area.
Double-click this icon to launch the SecureLogin Client Utility.
This icon is a shortcut for the SecureLogin functionality on your workstation.

1 Right-click the SecureLogin icon in the notification area.
2 Select the task you want to perform.
For example, select Add Applications to add, delete, and manage the applications.

Figure 2-1 The Advanced Preferences

Add Application
Manage Logins

Mew Login
Change Preferences Advanced
Change Passphrase ]
Refresh Cache v Active
Backup User Information About
Restore User Information Log Off User
Work Offline Close

The following table provides information on the tasks available in the menu. If a task does not
appear in the menu, your administrator has not enabled this functionality for you.

Option Description

Add Application Starts the Add Applications wizard. Enables an
application for single-sign on by creating a script
that automates the login.

Manage Logins Launches the SecureLogin Client Utility.

Adds login IDs (login credentials), links login IDs to
applications, manages password policies, and
manages SecurelLogin settings.

Accessing the SecurelLogin Client Utility 11
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Option

Description

New Login

Advanced > Change Preferences

Advanced > Change Passphrase

Advanced > Refresh Cache

Advanced > Backup User Information

Advanced > Restore User Information

Advanced > Work Online / Offline

Active

About

Log User Off Windows

Close

Enables you to create multiple single sign-ons or
login IDs for an application. For example, if you
have three accounts on the same application,
SecurelLogin manages the three sets of credentials.

SecurelLogin provides the option to select the
preferred account when the application starts.

Opens the SecureLogin Client Utility, with the
Preferences option selected.

Enables you to change your passphrase question or
passphrase answer.

Refreshes the local cache settings and updates
cache with any changes made at the associated
container or organizational unit level.

Backs up the SecurelLogin user information into a
file.

Restores SecureLogin information from the backup
file.

Toggles between the online and offline states of
SecurelLogin. When you work offline, SecureLogin
uses the local (secondary) cache rather than the
directory.

This option is not displayed in Standalone mode

Determines whether SecurelLogin is enabled
(active) or disabled.

Displays the SecureLogin version number and the
status of the data stores. The primary data store is
the directory. The secondary is the local cache.

Enables you to shut down all programs, including
SecurelLogin, and log out from the workstation.
Performs the same function as the Shut Down >
Log Off option on the Windows Start menu.

Shuts down SecureLogin.

Accessing the SecureLogin Client Utility



Automating Logging In to Applications

An application definition is a set of instructions telling SecureLogin how to handle the login for a
certain application. SecureLogin uses application definitions to automatically log you in to Windows,
Web, or Java applications. SecureLogin has predefined application definitions for some of the
applications. You can use the Application Definition Wizard to create new application definitions.

The wizard captures and stores your login name (username), password, and any other information
required for authentication.

You can also write your own application definitions. However, we recommend that you use the
Application Definition Wizard to create your application definition.

SecureLogin stores all application definitions in a secure encrypted cache on your computer and in
the corporate directory.

+ “Responding to Pop-Up Prompts” on page 13

* “Predefined Application Definitions” on page 14

+ “Enabling an Application for Single Sign-On Using a Predefined Application Definition” on
page 15

+ “Using the Default Selections” on page 17

+ “Using the SecureLogin Client Utility to Enable Applications for Single Sign-on” on page 18
+ “Using a New Application Definition to Enable Applications for Single Sign-on” on page 19
+ “Changing the Name of an Application Definition” on page 21

+ “Modifying an Application Definition” on page 21

+ “Deleting an Application Definition” on page 25

Responding to Pop-Up Prompts

After SecureLogin is installed on your desktop, SecureLogin watches for applications that are not
enabled for single sign-on. Upon detecting such an application, SecureLogin notifies to launch the
wizard window that prompts you to use a wizard to enable those applications for single sign-on and
thereby simplify future log ins. If you do not require single sign-on for the application, you can ignore
the notification. But on a Windows 10 computer, the wizard window launches soon after SecurelLogin
detects an application for single sign-on.

If SecureLogin detects an login screen on an application, it presents the following dialog box.

Automating Logging In to Applications 13
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Figure 3-1 Prompt to Enable for Single Sign-On

Do you want to single sign enable the screen?

% Yes, [ want to single sign using the default selections done by the wizard.
% Yes, [ want to single sign enable the screen using the wizard.

= Cancel, I do not want to single sign this screen at this time.

= No, Never prompt me to single sign this screen.

Select one of the following options:

*

| want to single sign using the default selections done by the wizard: Select | want to
single sign using the default selections done by the wizard option to create an application
definition using the default settings.

Through the default settings, you can create an application definition to handle the username
and password fields and submit button identified by the Wizard.

| want to single sign enable the screen using the wizard: If SecureLogin detects more than
two text fields or one button in a login dialog box, select | want to single sign enable the screen
using the wizard (Recommended) option. Through this you can review the fields identified by the
Wizard, confirm that correct fields are selected and button are identified.

| do not want to single sign this screen at this time: Select | do not want to single sign this
screen at this time if you do not want to enable an application for single sign-on at an instance.

Never prompt me to single sign this screen: Select Never prompt me to single sign this
screen if you do not want to enable an application for single sign-on. You are not be prompted to
enable the application for single sign-on, again.

Predefined Application Definitions

SecureLogin has predefined application definitions to automatically capture and store login
credentials for many common applications.

If a predefined application definition does not exist for your favorite application you, use Application
Definition Wizard to create a new application definition to capture and store your logon credentials,
along with any other information required for authentication. For details on using the Application
Definition Wizard, see the NetlQ SecureLogin Application Definition Guide.

Windows Applications

Some of the predefined application definitions for Windows applications include:

*

*

*

*

401K Web Login

ActiveSync

AOL Instant Messenger
Cisco VPN

Citrix Program Neighborhood

Automating Logging In to Applications
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*

Citrix Program Neighborhood Agent

*

Lotus Notes v5 and v6.5

*

Microsoft Outlook

*

Microsoft Outlook Express

Web Applications

Some of the predefined application definitions for Web applications are:

+ Amazon.com

+ eBay

+ Hotmail

+ QANTAS Frequent Flyer
+ CNN Member Services

+ Monster.com

Enabling an Application for Single Sign-On Using a
Predefined Application Definition

The procedure to use a predefined application definition to enable an application definition is the
same for all Web, Windows, and Java applications.
1 Launch an application.
If a predefined application definition exists for that application, SecureLogin
automatically detects the application definition.
The SecureLogin dialog box is displayed.
2 Select I want to single sign the screen using the predefined application definition.
SecureLogin identifies the application and displays the name of the application in the prompt.

3 You are prompted to specify the credentials for the application. Specify the username, password,
and any other information required.

4 Click OK.
SecureLogin saves your credentials and uses them to log in to the application.

The next time you launch the application, you are not prompted for username and password.
SecurelLogin provides this.

Enabling Single Sign-On for Novell WebAccess

The following example demonstrates enabling single sign-on for a Novell WebAccess. SecurelLogin
provides a predefined application for Novell WebAccess.

This procedure assumes that you already have a GroupWise account.

1 Launch Novell WebAccess.

A predefined application definition exists for Novell WebAccess. SecureLogin detects the
application and the SecureLogin dialog box is displayed.

Automating Logging In to Applications 15



Securelogin ==

Z:] SecureLogin has detected a password field on this screen

Window Title:  Novell WebAccess @ Show me

Application URL omail.novel.com

Do you want to single sign enable the screen?

Yes, I want to use the predefined application definition.
Movel GroupWise V7.0 Web Login

% Yes, I want to single sign enable the screen using the wizard.
< Cancel, I do not want to single sign this screen at this time.

< No, Never prompt me to single sign this screen.

2 Select | want to single sign the screen using the predefined application definition. Novell
GroupWise Messenger V7.0 Web Login.

The Wizard detects the name of the application and displays it. In this example, SecureLogin
identifies that you are creating an application definition for Novell GroupWise WebAccess and it
displays the name.

The Enter your GroupWise information dialog box is displayed.
3 Specify your Username and password, then click OK.

Enter your credentials (=53]
Novell
g Securelogin, N

Please enter you GroupWise information.

|Jsemame : || |

password | |

oK | Cancel |

SecurelLogin saves the credentials and uses them to log in to your GroupWise WebAccess account.
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To test the application definition, log out and log in. If the application is defined correctly with the
correct credentials, you are logged in successfully. If your login is not successful, delete the
application definition and repeat the above steps. You might also need to review the application
definition for completeness of event responses and errors.

Using the Default Selections

1 Launch the Web application for which you want to enable single sign-on.
2 Securelogin detects the application and prompts you to enable single sign-on.

Figure 3-2 Prompt to Enable for Single Sign-on

Do you want to single sign enable the screen?

= Yes, I want to single sign using the default selections done by the wizard.
= Yes, I want to single sign enable the screen using the wizard.
= Cancel, I do not want to single sign this screen at this time.

= No, Never prompt me to single sign this screen.

3 Select Yes, | want to single sign using the default selections done by the wizard.

4 The Enter your Credentials dialog box is displayed.

)

Enter your credentials

Z

“ Novell _
T Securelogin,

Please edi your login varables.

|semame: | |

Password: | |

ok | Cancel |

5 Specify your credentials, then click OK.

SecurelLogin saves your credentials in the directory. The next time you launch the application,
SecureLogin provides the credentials for you.

Automating Logging In to Applications 17



Using the SecureLogin Client Utility to Enable
Applications for Single Sign-on

You can enable an application for single sign-on through the SecureLogin Client Utility as well as
through the Application Definition Wizard.

1 Double-click the SecureLogin icon @ in the notification area. This launches the SecureLogin
Client Utility with the Application menu selected.

2 Click | INew| Alternatively, select File > New > Application. The New Application dialog box

appears.

New Application

401K Web Logon
ActiveSync

ACQL Instant Messenger

Cizco VPN

Citrix Program MNeighborhood

Citrix Program Meighborhood Agent
Citrix Web Portal

CMNM Member Services

Cyberview

eBay

Entrust Client

Entrust Server

Eudara eMail

ExcelCare Application

EzTeller

Firewall-1 Session Authentication Aocent

" New Application Definition
Type | J

EXE |

Description |

K ‘ Cancel |

3 From the Predefined Application Definition list, select the appropriate application definition.
4 Click OK. Details of the selected application appear.
5 On the Details page, specify the username and password of the application.

Automating Logging In to Applications



¥ Novell 550

E Novell SecurelLogin,

=-_] Applications Application - "Yahoo! Messenger"

E Java .
: Details iti i
Ea Web |Deﬁn|t|or| I Settings I
=-E3 Windows
----- B Activesync [ Yahoo! Messenger (Windows) Edit |

----- £ ACL Instant Messenger
----- 1 GroupWise Password
----- [ https:/finnerweb.novell..
----- 1 Microsoft Metworking Clie  radentials
----- E Microsoft Outlook S -
----- 1 Movell Bugzilla g |Mew i D=lete @%Show passwords
..... Al

1 Movell Group\ Jize Meszel B
_____ EI Movell iFolder v2x

Username

YPAGER.EXE ¥ Enabled

----- [ ¥ahoo! Messenger Password

+-{&2 My Logins
[]-- Preferences

-{Z Password Policies

r |

|~

oK | Cancel Apply

6 (Optional) Click the Settings tab and define your preferences.
7 Click Apply to apply the new login details.
8 Click OK to save and exit.

Using a New Application Definition to Enable
Applications for Single Sign-on

1 Double-click the SecureLogin icon @ in the notification area. This launches the SecureLogin
Client Utility with the Application menu selected.

2 Click % |new Alternatively, select File > New > Application. The New Application dialog box
appears.

3 Select New Application Definition.

Automating Logging In to Applications 19



New Application

" Predefined Application Definition

X

01K Web Logon

w
' New Application Definition:
Type |'v'u'inu:|u:|u\'s ﬂ
EXE |
Description |

Ok | Cancel |

4 From the Type drop-down list, select the type of application.

You can select:

*

*

*

Windows

Terminal Launcher
Startup

Java

Generic
Advanced Web
Web wizard Script

NOTE: For Flash application, select type as Windows. Use Flash Window finder tool to read the
title of the application and provide the same in the EXE text box.

(2B &)

Specify other details such as the name, the URL, executable, and description as required.
Click OK.

You have successfully added an application. You now need to specify the credentials for the
application.

© o0

From the Application navigation tree on the left pane, select the application you created.
Specify the username and password of the application.
(Optional) Specify the application definition of this application.

10 (Optional) Change the default settings to suit your requirements.

11 Click Apply. Your applications details are added to SecureLogin.
12 Click OK to save and exit.
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Changing the Name of an Application Definition

1 Double-click the SecureLogin @ icon in the notification area.
2 In the Application navigation area on the left panel, select the application you want to modify.

3 Click . The Edit dialog box appears.
Edit X

Edit details for "MOVELL: Login®
T =l MOVELL : Login

d |

e | =

Ok | Cancel |

4 Make the required changes. You can modify the name, ID, and type of the application.
5 Click OK. The changes are saved.

Modifying an Application Definition

This section provides information on modifying the application definitions created using the
Application Definition Wizard. You can use the Application Definition Wizard to add or modify the
definition, add notifications for password change and login notifications.

NOTE: Predefined application definitions cannot be edited using the Application Definition Wizard.
You must edit them manually. To know more about editing the application definitions manually, refer
the NetlQ SecureLogin Application Definition Guide.

You can modify the Application Definition Wizard in one of the following ways:

Modifying through the Application Definition Wizard

1 Double-click the SecureLogin icon on the notification area.

The Application Definition Wizard opens displaying a list of application enabled for single sign-
on.

Automating Logging In to Applications
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¥ Novell 550 - [cn=writer,0=novell]

File Help

E Novell SecurelLogin,

(SR} Applications Applications
L) Web

E - [38 Windows | New Delete

#-{E8 My Logins —

-- Preferences Application Type 1d

= Password Policies Citrix Program Meighborhood Agent  Windows PMAGENT.EXE
Meditech Windows wmagic. exe
Microsoft SQL Windows isqlw.exe
Microsoft Windows Live ID Web Wizard Script  live.com
Yahoo! Mail: The best web-based e... Generic Wizard login. yahoo.com

l_ oK ] [ Cancel Apply

2 From the Applications pane, select the application deviation you want to modify.
3 Click the Definition tab.

iexplore.exe - Yahoo! Mail: The best web-based..."

=] Logon
=1 ahoo! Mail: The best web-based...
=] k’?) Logon Motification
[y Mew Logon Motification Form
@ Change Password
% Change Password MNotification
Other

| Convert To Appication Definition || Edit wizard |

Lok J[ cancel | [ ooy |

4 Select Edit Wizard. The attributes pane opens enabling you to edit the application definition.
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Securelogin o] = |
Application Screens Yahoo! Mail: The best web-based...
New v | X 2 Identify screen 7
= il_:'=_1 iexplore.exe - Yahoo! Mail: The best wet — )
= Logon @ Securelogin needs to idertify the logon screen for this application. You can choose or -
=] yahoo! Mail: The best web-basze GETEE e AT TR '
= \E‘;J Logon Motification
@ Mew Logon Motification Form
@ Change Password . o
g Change Passward Natification Choose the logon screen for this application
Other Drag the Choose icon onto the logon screen. [R Choose
This SecureLogin window will move behind all other
windows while you select the target screen.
Screen Title Yahoo! Mail: The best web-based. .. @ Show me
@ Credential source Q?
T Identify fields &
% Re-authentication &
@ Submit options 7
] 1 b @ Matching criteria o
Help ] [ Test oK ] [ Apply ] [ Cancel ]
There are incomplete screen attributes that require mare information

5 Make the changes.
Each of the attributes are explained in detailed in the earlier section.
6 Click Apply and OK to save and exit.

Modifying through the Manage Logins Menu

1 Right click the SecureLogin icon on the notification area, then select Manage Logins.

Add Application
Manage Logins
Mew Login

Advanced k

v Active
About

Log Off User

< Close

Automating Logging In to Applications 23
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The administrative management utility displays a list of applications that are already enabled for
single sign-on.

W Novell S50 - [cn=writer,0=novell]

File Help

f', Novell SecureLogin,

Applications |

& C3 Windows o | New S Delete
--E@ My Logins —
" Preferences Application Type Id
E? Password Policies Citrix Program Meighborhood Agent  Windows PMAGENT.EXE
Meditech Windows vmagic.exe
Microsoft SQL Windows isglw.exe
Microsoft Windows Live ID Web Wizard Script  live.com
‘fahoo! Mail: The best web-based ... Generic Wizard login.yahoo.com
[ ok ][ conel Apply

2 From the Applications pane, select the application deviation you want to modify.

3 Click the Definition tab.

Application - "iexplore.exe - Yahoo! Mail: The best web-based..."

= Logon
1 ¥ahoo! Mail: The best web-based. ..
= @?) Logon Motification
gy Mew Logon Motification Form
[Al change Password
% Change Password MNotification
Other

| Convert To Appication Definition || Edit Wizard |

L ooc J[ cancel | [ mooy |

4 Select Edit Wizard. The attributes pane opens enabling you to edit the application definition.

Automating Logging In to Applications



Securelogin o] = |

Application Screens Yahoo! Mail: The best web-based...

Mew | * 'aldenﬁfv screen Q?

= il_:'=_1 iexplore.exe - Yahoo! Mail: The best wet — )
= Logon ¥ Securelogin needs to identify the logon screen for this application. You can choose or -

=] yahoo! Mail: The best web-basze GETEE e AT TR

= \E‘;J Logon Motification
@ Mew Logon Motification Form

@ Change Password . o
g Change Password Notification Choose the logon screen for this application

Other Drag the Choose icon onto the logon screen. R Choose

This SecureLogin window will move behind all other
windows while you select the target screen.

Screen Title Yahoo! Mail: The best web-based. .. @ Show me

@ Credential source
'Zp Identify fields
% Re-authentication

@ Submit options

LR R RR

] 1 b @ Matching criteria

Help ] [ Test oK ][ Apply H Cancel ]

There are incomplete screen attributes that require mare information

5 Make the changes.
Refer the NetlQ SecurelLogin Application Definition Wizard Administration Guide
6 Click Apply and OK to save and exit.

Deleting an Application Definition

1 Double-click the SecureLogin @ icon in the notification area.
2 In the Application navigation on the left panel, right-click the application you want to delete.
3 Click Delete. The selected application is deleted.
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Creating Login Credentials

SecureLogin allows you to enable multiple logins for single sign-on to the same application.

Through the My Login page, you can view and edit SecureLogin user data, such as usernames and
passwords that allow you to successfully log in to an application.

To use SecurelLogin to automatically log you in to an application, you must create a Login (set of
credentials) and link it to that application.

If you add an application that has a predefined application, you need to link the login to it. You can
provide login variables the next time that you access the application. However, you do not need to
add or create login for applications that you enabled for single sign-on in the following ways:

+ If you encountered a new application through a pop-up prompt and then used the Add
Applications wizard to enable the application.

+ If you ran the Add Applications wizard and selected a Web Page or Windows Application option
as the script type.

In these two cases, the Application Definition Wizard created the login while you were adding the
application to the single sign-on functionality.

You can use the same login to log you in to more than one application.

Also, if you have multiple roles, you can set up multiple logins for the same application. For example,
you might be a network administrator as well as a user. When you log in to the network as
administrator and then launch an application, SecureLogin prompts you to select a profile. After you
select the administrator profile, SecureLogin then automatically logs you in with the appropriate
credentials.

Creating Login Credentials Using the Add New Login
wizard

+ “Creating the Login” on page 27

+ “Specifying the Credentials” on page 28

+ “Linking a Login to an Application” on page 28

+ “Delinking a Login from an Application” on page 28

Creating the Login

1 Right-click the SecurelLogin icon in the notification area, then click Manage Logins.

or,

Double-click the SecurelLogin icon in the notification area.
This launches the SecureLogin Client Utility.

2 Click My Logins > New.

3 Specify a name or ID in the Create Login dialog box, then click OK.
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You have now successfully created a new login. Repeat Step 1 on page 27 through Step 3 on
page 27 to create other logins.

However, you need to specify the username and password to this login.
Repeat Step 1 through 4 to create other logins.

4 Continue with “Specifying the Credentials” on page 28 to specify the username and password for
this login.

Specifying the Credentials

In the previous task, you created a login. Use the following steps to specify the credentials for your
login,
1 Inthe My Login list in the left panel, select the login you created. The login page is displayed.
2 Select Username, then specify the username in the adjacent text field.

3 Select Password, then specify the password in the adjacent text field. The password is displayed
as a series of asterisks.

Select @Show passwords , it displays the actual password, instead of a series of asterisks.

4 Click Apply, then click OK. Your login credentials are saved.
Repeat Step 1 on page 28 through Step 4 on page 28 to specify the credentials to other logins.

Linking a Login to an Application
To add a newly created login to an application:

1 From My Logins, select the login that you want to link to an application.

2 Click m The Applications List window opens.
3 Select the applications you want to link to this login. Click OK.
4 Click Apply, then click OK. The login information is saved.

Delinking a Login from an Application
1 From My Logins, select the login that you want to delink to an application.

2 Click ="k | The Application List window opens.
3 Select the applications you want to delink from the login.
4 Click Apply, then click OK. The change is saved.

Adding Multiple Logins

+ “Prerequisites” on page 29

+ “Creating Another Login” on page 29

+ “Viewing the Additional Login” on page 30
+ “Testing the Multiple Logins” on page 30
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Prerequisites

+ Before you commence adding another login to an existing login, the first account must be
enabled for single sign-on.

+ Before you add multiple logins to the first account, we recommend that you make a list of the
usernames, passwords, and a unique name to identify the login.

The following is an example list;

Table 4-1 List of Additional Logins

Name User Name Password
Administrator admin 123456
Support help abcdef
User testl Xyz123

Creating Another Login

1 Right-click the SecureLogin icon in the notification area, then select New Login. The
SecurelLogin - Add New Login wizard welcome dialog box is displayed.

Sacurelogin,- Add New Login X

Welcome to the Add Mew Login Wizard.
Novell To add a new login, select the application you want to

Secure L{}ginr add the login for, then dick Next.

Available applications:

Movell Bugzilla
Movell GroupWise Messenger Version 2.0

| Movell iManager
s, Movell iManager
-4 MOVELL: Login
NOVELL: Login
user account | TWIN: Technical Writers of India
Yahoo! Mail
‘fahoo! Messenger

>

(=

| Mext = Cancel

2 Select the required application.
3 Click Next. A page displays where you can provide a description for the login.
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Securelogin - Add New Login

Enter a description for this new login and then dick
Novell . Finish. When you next run the application, if vou

SE cure LDgII’I_ select the new login set that you have just created
you will be prompted to enter your details to save in
this new login set.

Description:

< Back | Finish | Cancel |

4 In the Description field, specify a descriptive name for the login (for example, NSL
Administrator).

Click Finish. A page appears where you can enter your credentials.
In the Username field, specify the username.
In the Password field, specify the password.
Specify any additional variables as required.

© 0 N o O

Click OK to save your information and exit the SecureLogin Client Utility.

10 Repeat Step 1 on page 28 through Step 9 on page 30 to add any additional logins. When you
have created all logins, you can view and manage them in the SecureLogin Client Utility.

Viewing the Additional Login

1 Right-click the SecureLogin icon in the notification area, then select New Login. The
SecurelLogin - Add New Login wizard welcome dialog box is displayed.

2 In the navigation tree, select My Logins. The My Login page is displayed.
3 Verify that the additional login is added to the My Logins pane.
4 Click OK to close the SecureLogin Client Utility.

Testing the Multiple Logins

1 Launch the application for which you added multiple logins.
2 Select the functionality you want to access. The login selection dialog box is displayed.
3 Select the appropriate login credential set.

4 Click OK. SecureLogin enters the credentials and you are automatically logged in to the
application.
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5 Changing Preferences

The Preferences allow you to customize SecureLogin. Use this option to customize SecureLogin to

function in the way you want it.

The Administrator can also set the SecureLogin user preferences in the Administrative Management
utility. Each preferences has a default value until an alternative value is specified.

NOTE: The preferences value set by you at the user object level overrides all higher level object

values.

The list of preferences is a subset of the preferences that the administrator controls through the

Administrative Management utility. If the Administrator has disabled a setting, you cannot use it or

change it on your workstation.

*

*

*

*

*

“Viewing and Changing the Preferences” on page 31

“General Preference, Definitions, and Values” on page 32

“Java Preference, Definitions, and Values” on page 35

“Web Preferences, Definitions, and Values” on page 36

“Windows Preferences, Definitions, and Values” on page 38

Viewing and Changing the Preferences

1 Click Preference. The preference properties table is displayed.

2 Select the setting you want to customize. You can change the preferences for the following
settings:

*

*

*

*

“General Preference, Definitions, and Values” on page 32
“Java Preference, Definitions, and Values” on page 35
“Web Preferences, Definitions, and Values” on page 36
“Windows Preferences, Definitions, and Values” on page 38

3 From the drop-down list in the VValue column, select the appropriate value.
4 Click OK.
5 Click Yes to save the settings and exit.
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Figure 5-1 The User Preferences

E Novell SecureLogin,

-] Applications
+ E Web
¥ E Windows
+-[E5] My Logins
=143
General
{3y Java
iy Web
iy Windows
|& Password Policies

General Preference, Definitions, and Values

Table 5-1 The General Preferences Properties Table

Preference Possible Description Default Value
Values

Displaylogged Disable/First This preference controls the display of the  The default

onuserintask name/Last logged in user name on the task bar. value is
bar name/Full ) o ) . Disable.
name/ If this option is set to Disable, the logged in
Distinguishe User name is not displayed on the task bar.
dname/ If this option is set to First name/Last name/
Default

Full name/Distinguished name/Default,
based on the selection respective value is
displayed on the task bar.

NOTE: For the logged in user name to be
displayed in the task bar, you must right-
click the Secure Login icon on the
notification area (system tray) and select
Show User bar or you can right-click on the
task bar and select Toolbars ->
SecureLogin SSO User.

This preference is available in both the
SecurelLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Preference Possible Description Default Value
Values

Detect Yes/No/ Predefined applications generally include The default
incorrect Default commands to respond to incorrect value is Yes.
passwords password dialogs. This preference enables

SecurelLogin to respond to incorrect

passwords for web applications.

If this option is set to Yes or Default,
incorrect passwords for Web applications
are detected.

If this option is set to No, incorrect
passwords for Web applications are not
detected.

This preference is available in both the
SecurelLogin Client Utility and the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

Enable cache Yes/No/ This preference controls creating and The default
file Default updating of a SecureLogin cache file on the value is Yes.
local workstation. The cache file stores all
user configuration data; local and inherited.

Set this option to Yes for mobile users.

If this option is set to No, you cannot store
files locally or you might have some
conflicts with organizational security policy.

If this option is set to Default, SecureLogin
behaves as if it is set to Yes.

This preference is available in both the
SecurelLogin Client Utility and the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

Enter API Specify API Specify the API license key(s) provided by  Specify the API
license key(s) license key(s) SecurelLogin to activate the API license key
functionality for an application.

You can add more than one API license key.
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Preference

Possible
Values

Description Default Value

Password
protect the
system tray
icon

Provide API
Access

Set the cache

refresh
interval (in
minutes)

Yes/No/
Default

Yes/No/
Default

5

This preference restricts the users from The default
accessing the SecurelLogin icon menu value is No.
option (from the notification area (system

tray) without their network login password.

If this option is set to Yes, the SecureLogin
icon on the notification area (system tray) is
password protected.

If this option is set to No or Default, the
SecurelLogin icon on the notification area
(system tray) is not password protected.

This preference is available in both the
SecurelLogin Client Utility and the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

This preference controls the API The default
functionality use. value is No.

If this option is set to Yes, the API access is
enabled.

If this option is set to No or Default, the API
access is disabled.

This preference is available in both the
SecureLogin Client Utility and the
administrative management utilities
(iManager, SLManager, and MMC snhap-
ins).

This preference defines the time in minutes The default
the synchronization of user data and value is setto 5
directory on the local workstation. minutes.

However, depending on the network traffic

and the number of users the interval can be
set between 240 minutes and 480 minutes

(four and eight hours).

This preference is available in both the
SecureLogin Client Utility and the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Java Preference, Definitions, and Values

Table 5-2 The Java Preferences Properties Table

Preference

Possible
Values

Description

Default Value

Add application
prompts for
Java
applications

Allow single
sign-on to Java
applications

Yes/No/
Default

Yes/No/
Default

This preference controls whether The default
SecurelLogin detects Java application. value is No.

If the preference is set to Yes or Default,
as soon as SecurelLogin detects a Java
application login page, it prompts the user

to record it.

If this option is set to No, this process
never occurs, only Java predefined
applications are prompted and supported.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-

ins).

This preference controls whether The default
SecurelLogin allows single sign-on for Java value is Yes.

applications.

If the preference is set to Yes or Default,
as soon as SecurelLogin detects a Java
application login page, it prompts the user
to enable it for single sign-on.

If this option is set to No, Java applications
are not enabled for single sign-on.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-

ins).
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Web Preferences, Definitions, and Values

Table 5-3 The Web Preferences Properties Table

Preference

Possible
Values

Description Default Value

Add application
prompts for
Internet
Explorer

Add application
prompts for
Mozilla Firefox

Yes/No/
Default

Yes/No/
Default

This preference controls the display of the The default
Web login detection wizard and value is Yes.
confirmation dialog box when a Web

application is detected and recognized by

Internet Explorer.

If you select Yes or Default, the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin skips
enabling the application for single sign-on
on this instance. You are prompted to
enable the application when you launch it
the next time.

This preference is available in both the
SecurelLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

This preference controls the display of The default
Web login detection wizard and value is Yes.
confirmation dialog box when a Web

application is detected and recognized by

Mozilla Firefox.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin skips
enabling the application for single sign-on
on this instance. You are prompted to
enable the application when you launch it
the next time.

This preference is available in both the
SecurelLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Preference

Possible
Values

Description Default Value

Add application
prompts for
Google Chrome

Allow single
sign-on to
Internet
Explorer

Allow single
sign-on Mozilla
Firefox

Yes/No/
Default

Yes/No/
Default

Yes/No/
Default

This preference controls the display of The default
Web login detection wizard and value is Yes.
confirmation dialog box when a Web

application is detected and recognized by

Google Chrome.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin skips
enabling the application for single sign-on
on this instance. You are prompted to
enable the application when you launch it
the next time.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

This preference defines single sign-on The default
access to Web application using Internet  value is Yes.
Explorer.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin does not
prompt for credentials (if none exist or are
incorrect) and does not submit credentials
into the application.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

This preference defines single sign-on The default
access to Web application using Mozilla value is Yes.
Firefox.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin does not
prompt for credentials (if none exist or are
incorrect) and does not submit credentials
into the application.

This preference is available in both the
SecurelLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Preference Possible Description Default Value

Values
Allow single Yes/No/ This preference defines single sign-on The default
sign-on Google Default access to Web application using Google  value is Yes.
Chrome Chrome.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin does not
prompt for credentials (if none exist or are
incorrect) and does not submit credentials
into the application.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).

Windows Preferences, Definitions, and Values

Table 5-4 The Windows Preferences Properties Table

Preference Possible Description Default Value
Values

Add application Yes/No/ This preference controls the display ofa  The default

prompts for Default Windows login detection and confirmation value is Yes.

Windows message when a Windows application is

applications detected and recognized.

If you select Yes or Default, the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin skips
enabling the application for single sign-on
on this instance. You are prompted to
enable the application when you launch it
the next time.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Preference Possible Description Default Value
Values

Allow single Yes/No/ This preference controls the display of The default

sign-on to Default Windows login detection wizard and value is Yes.

Windows confirmation dialog box when a Windows

applications

application is detected and recognized by
Mozilla Firefox.

If you select Yes or Default the specified
credentials are saved and the application
is enabled for single sign-on.

If you select No, SecureLogin skips
enabling the application for single sign-on
on this instance. You are prompted to
enable the application when you launch it
the next time.

This preference is available in both the
SecureLogin Client Utility and all the
administrative management utilities
(iManager, SLManager, and MMC snap-
ins).
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Managing Your Passwords

SecurelLogin provides the password policy functionality to enable you to effectively and efficiently
manage your password.

Organizations and applications often have rules about the content of passwords, such as the required
number of characters and type of characters. The Password Policies option in SecureLogin, the
SecureLogin Client Utility provides functionality to create and enforce these password rules through a
Password policy, and apply this policy to one or more application logins.

+ “Creating a Password Policy” on page 41

+ “Editing a Password Policy” on page 45

+ “Deleting a Password Policy” on page 46

Creating a Password Policy

1 Double-click the SecureLogin @ icon in the notification area.

2 Click Password Policies, then click % [New| The New Password Policy dialog box is displayed.

Mew password policy P§|

Enter a name for the new password policy

oK | Cancel

3 Specify a name for your password policy, then click OK.

You have now successfully created a new password policy, but you need to set your preferences
for the password policy. These preferences are unique to you and are enforced on your
workstation.

4 Inthe Password Policies navigation area, select the password policy you want to edit.
5 You can view and change the following settings:
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Policy

Value To Be provided

Description

Minimum length

Maximum length

Minimum punctuation
characters

Maximum punctuation
characters

Minimum uppercase characters

Maximum uppercase
characters

Minimum lowercase characters

Maximum lowercase characters

Minimum numeric characters

Maximum numeric characters

Disallow repeat characters

Whole number

Whole number

Punctuation characters

Punctuation characters

Whole number

Whole number

Whole number

Whole number

Whole number

Whole number

No/Yes/Yes, case
insensitive

Defines the minimum length of the
password; that is, the number of characters
required for the password.

Defines the maximum length of the
password; that is, the maximum number of
characters allowed in password.

Defines the minimum number of
punctuation characters allowed in a
password.

Defines the maximum number of
punctuation characters allowed in a
password.

Defines the minimum number of uppercase
characters allowed in a password.

Defines the maximum number of uppercase
characters allowed in a password.

Defines the minimum number of lowercase
characters allowed in a password.

Defines the maximum number of lowercase
characters allowed in a password.

Defines the minimum number of numeric
characters allowed in a password.

Defines the maximum number of numeric
characters allowed in a password.

Disallows the use of repeated characters,
or the use of the same successive
characters.

If this option is set to No, characters can be
repeated. This is the default value.

If this option is set to Yes, same alphabetic
characters in a different case are
considered as different characters. For
example, A and a are different.

If this option is set to Yes, case
insensitive, the successive use of the
same alphabetic characters in a different
case is not allowed.
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Policy

Value To Be provided

Description

Disallow duplicate characters

Disallow sequential characters

Begin with an uppercase
character

End with an uppercase
character

No/Yes/Yes, case
insensitive

No/Yes/Yes, case
insensitive

No/Yes

No/Yes

Disallows the use of the same non-
successive characters.

If this option is set to No, duplicate
characters are allowed. This is the default
value.

If this option is set to Yes, the same
alphabetic characters in a different case are
considered as different characters. For
example, A (uppercase) and a (lowercase)
are different.

If this option is set to Yes, case
insensitive, duplication of the same
alphabetic characters in a different case is
not allowed.

Disallows the use of successive characters
in alphabetical order.

If this option is set to No, sequential
characters are allowed. This is the default
value.

If this option is set to Yes, sequential
characters in a different case are
considered as non-sequential. For
example, a and B are non-sequential.

If this option is set to Yes, case
insensitive, sequential characters in
different cases are disallowed.

Enforces the use of an uppercase
alphabetic character as the beginning
character of a password.

The default value is No.

If this option is set to Yes, all other policies
that indicate that a password must begin
with a particular character or in a specific
manner are disabled.

IMPORTANT: Only one type of character
can be designated as the first value of a
password.

Enforces the use of an uppercase letter at
the end of a password.

The default value is No.

If this option is set to Yes, all other policies
that indicate that a password must end with
a particular character or in a specific
manner are disabled.

Managing Your Passwords

43



44

Policy Value To Be provided

Description

Prohibited characters Keyboard characters

Begin with any Alpha character No/Yes

Begin with any number No/Yes

Begin with any symbol No/Yes

End with any Alpha character No/Yes

End with any number No/Yes

Defines a list of characters that cannot be
used in a password.

NOTE: There is no need of a separator in
the list of prohibited characters. For
example, @#$%&*

Enforces the use of an alphabetic character
at the beginning of a password.

The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the first character of the password should
be.

Enforces the use of a numeric character as
the first character of the password.

The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the first character of the password should
be.

Enforces the use of a symbol character as
the first character of the password.

The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the first character of the password should
be.

Enforces the use of an alphabetic character
as the last character of the password.

The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the password should end with.

Enforces the use of a numeric character as
the last character of the password.

The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the password should end with.
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Policy Value To Be provided Description

End with any symbol No/Yes Enforces the use of a symbol character as

the last character of the password.
The default value is No.

If this option is set to Yes, it automatically
disables all other policies that specify what
the password should end with.

6 Click Apply. The settings are saved.

Editing a Password Policy

To edit an existing password policy settings:

1 Double-click the SecureLogin @icon in the notification area.

2 Inthe Password Policies navigation area, select the password policy you want to edit. The
settings of the selected password policy are displayed.

—

Novell 550
File Help

i Novellsecurslogn [

Password Policy - "my-password-policy”

EEl Applications
w3 web

- Windows
[+-{25 My Logins
=-#cs Preferences

E@ Password Policies

I 1y -password-policy

Minimum length
Maximum length
Minimum punctuation characters

General Maximum punctuation characters
gy JEV: Minimum uppercase characters
..... i

?i; ::nf p Maximum uppercase characters
indows

Minimum lowercase characters
Maximum lowercase characters
Minimum numeric characters
Maximum numeric characters

Disallow repeated characters Ma
Disallow duplicate characters Mo
Disallow sequential characters Mo
Beqgin with an uppercase character Ma
End with an uppercase character Mo
Prohibited characters

Beqgin with any alpha character Ma
Begin with any number Mo
Begin with any symbaol Mo
End with any alpha character Mo
End with any number Mo
End with any symbol Mo

QK Cancel Apply
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3 Select the setting you want to change.

4 In the adjacent column, change the value of the settings as required. Refer to “Creating a
Password Policy” on page 41 for the setting options and their descriptions.

5 Click Apply.

Deleting a Password Policy

1 Double-click the SecureLogin icon in the notification area.

2 Inthe Password Policies navigation area, right-click the password policy you want to delete,
then click Delete.
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Managing Information Cache

Use the Advanced menu to change your information cache to refresh the cache, back up and restore
information, and work online or offline.

Figure 7-1 The Advanced Menu

Add Application
Manage Logins

MNew Login

Change Preferences Advanced
Change Passphrase Act
Refresh Cache v Actve

) About
Backup User Information
Restore User Information Log Off User
Work Offline Close

+ “Refreshing the Cache” on page 47
+ “Backing Up User Information” on page 48
+ “Restoring User Information” on page 49

+ “Working Online and Working Offline” on page 51

Refreshing the Cache

The SecurelLogin cache is encrypted local copy of SecureLogin data. It allows users who are not
connected to the network, for example, if they are working offline or using a laptop, to continue using
SecureLogin even if the directory is unavailable.

By default, a cache file is created on the workstation as part of the SecureLogin installation. The
cache file stores your data locally and is synchronized regularly with your data in the directory.

The directory and workstation caches are synchronized regularly, by default every five minutes.

To refresh the cache manually:

1 Right-click the SecureLogin @icon in the notification area, then select Advanced > Refresh
Cache.

The cache is refreshed and it is synchronized with the cache in the directory.
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Backing Up User Information

Because Securelogin data is stored in the directory, existing directory backups also back up
SecurelLogin data. In addition, the local cache synchronizes with the directory for further redundancy
of data.

Backing up or restoring by using the SecureLogin menu options is typically performed by users who
have been disconnected from the network for long periods of time, such as weeks or months.

To create a backup file:

1 In the notification area, right-click the SecureLogin icon, then select Advanced > Backup User
Information. The Save Settings dialog box is displayed.

Add Application
Manage Logins

Mew Login
Change Preferences
Change Passphrase At
Refresh Cache v Actve
| ———— About
C.:Ea_u:icu_pUser Infuﬂa_@_n.}
Restore User Information Log Off User
Waork Offline Close

2 Select a folder where you want to store the backup file.
The file can be stored in any location.

Save As

Save in: |l.f} SecursLogin ﬂ IfF -

[Cslomoz_1_5

B

My Recent
Documents

:

~

D

@
(%]
&
=]

=

\$

My Documents

File name: | -

|}(|"."|L Document (*esx) j

Iy Metwork
Flaces

Save as type:

3 Inthe File name field, specify a name for the backup file.
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4 Click Save. The Password dialog box is displayed.

Password r5__<|

Please enter a password (minimum 8 characters)

Password |

Confirm Password |

oK Cancel

5 Inthe Password field, specify a password.

6 Click OK.
The encrypted and password-protected backup file is saved, and a confirmation message
appears.
Securelogin r5_(|

i ) Securelogin data has been saved.

1 Active Passphrase Question
5 Preferences

0 Passphrase Questions

0 Password Policies

1 Passphrase Paolicy

22 Applications

25 Application Preferences
40 Logins

34 Linked Logins

99 Credentials

7 Click OK.

Restoring User Information

IMPORTANT: Before restoring the backup file, you must delete the cache file on the workstation.

Deleting the Workstation Cache

1 Right-click the Windows Start button, then click Explore.
2 Browse to the following directory:
C.\Docunments and Settings\[user]\Application Data\SecureLogi n\ Cache

Ensure that you have selected Show hidden files and folders in the Windows Folder Options
dialog box.

3 Delete the cache directory.
4 Close Windows Explorer.
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Restoring the Backup File

To restore the user information from the local cache backup file:

1 In the notification area, right-click the SecureLogin icon, then select Advanced > Restore
User Information. The Load Settings dialog box is displayed.

Open 2

Look in: |I.:",' SecureLogin :J L ek B2~
E [Chslomoz_1_5
Lﬁ Test.esx
My Recent
Documents
=
E:
Desktop

My Documents
My Computer
‘g File name: | L] COpen
My Metwork  Files of fype: |XI'~"|L Document * esx) LJ Cancel
Places

[ Open as read-only

2 Select the backup file.
3 Click Open. The Password dialog box is displayed.

Password

Please enter password

Password

oK | Cancel |

4 In the Password field, specify the password.
5 Click OK.
A message appears, confirming that cache data has been loaded to the local workstation cache.
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SecurelLogin E|

jr) Securelogin data has been loaded.

1 Active Passphrase Question
1 Preference

0 Passphrase Questions

0 Password Polices

1 Passphrase Policy

16 Applications

18 Application Preferences
40 Logins

34 Linked Logins

99 Credentials

6 Click OK.

Working Online and Working Offline

The Work Offline option stops the synchronization process with the directory, so SecureLogin relies
only on its local cache file or equivalent smart card.

If this option is set to Yes in the Administrative Management utility by the administrator, the Work
Offline option is not displayed on the notification area icon.

SecurelLogin detects if it is online or offline and adapts its behavior accordingly.

If this option is set to either No or Default, the Work Offline option is displayed and accessible in on
the notification area icon.

To work offline:

1 In the natification area, right-click the SecureLogin @ icon, then select Advanced > Work
Offline.

The synchronization process with the directory stops.
To work online:
1 In the natification area, right-click the SecureLogin @ icon, then select Advanced > Work

Online.

You are now working online and the synchronization with the directory is active.
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Managing the Passphrase

Passphrases are an important security component in the implementation of SecureLogin.
Passphrases are unique question and answer combinations created to verify and authenticate the
identity of a user. In a directory environment, you can create passphrase questions for users. Users
can select one of these questions and provide an answer for it. You can also permit users to provide
a question of their choice and the answer for it.

Passphrases protect user credentials from unauthorized use. For example, in a Microsoft Active
Directory environment, you can potentially log in to the network by resetting the user’s network
password.

However, this cannot happen when you are using SecureLogin. If someone other than the actual
users tries to reset the network password, SecurelLogin triggers the passphrase question. The user
must provide the correct answer before successfully logging in. Even an administrator cannot access
the user’s single sign-on-enabled applications without knowing the user’s passphrase answer.

NOTE

In a Microsoft Windows Vista environment, when you log in to SecureLogin in an offline mode with an
incorrect password, you are prompted to provide the passphrase answer. If an incorrect passphrase
answer is specified, you are prompted to retry the authentication.

However, if you again provide a wrong password, instead of seeing a prompt for the passphrase
answer, you are prompted to specify the password (that is, instead of the passphrase dialog box, the
password dialog box is displayed).

Close and relaunch SecurelLogin to be prompted for the password first, then prompted for the
passphrase answer if the incorrect password is specified.

Creating a Passphrase

The first time log in to your workstation and launch SecurelLogin, you are prompted to set up your
passphrase question and answer.

If you have installed SecureLogin in LDAP GINA mode with eDirectory, SecureLogin does not work
while setting a passphrase for a new user if the eDirectory user’s fully distinguished name (FDN) has
128 characters or more.

1 The Passphrase Setup dialog box is displayed.
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Passphrase Setup

‘::' Mgé“t‘:una-Lr:u\:;in,,

If you need to access your single sign-on details when you are not connected
to the network ar if your password is ever reset, SecureLogin will ask you a
passphrase guestion. You must then enter your passphrase answer.

1. Select or enter & passphrase guestion.
2. Enter and confirm a passphrase answer.

Enter an obscure answer so that no one is likely to guess it.

Enter a question:

| [

Enter the answer:

Confirm the answer:

|
corcs

If your administrator has defined a set to question, you must select one of the questions and
specify your answer.

In the Enter a question field, select or specify a passphrase question.
In the Enter the answer field, specify the new passphrase answer.
In the Confirm the answer field, retype the new passphrase answer.

a b~ W N

Click OK. The changes are saved.

NOTE: You are re-prompted for the passphrase answer in the following situations:
+ If your administrator has changed the Security preference from Hidden to Yes, you are promoted
to re-enter your passphrase question and answer.
+ If you have logged in through the Workstation only when;
¢ The eDirectory™ and workstation passwords are different
and
¢ HKLM SO t war e/ Prot ocoml Secur elLogi n\ TryRegcredl nOf flineissetto 1

Specify your passphrase again (after the initial set up) to continue with the login.
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Changing a Passphrase

Passphrases protect your credentials from unauthorized use. For example, in an Active Directory
environment, you can potentially log in to the network by resetting the user’s network password. You
can avoid such occurrences by using a passphrase.

However, this cannot happen if you are using a SecureLogin passphrase. If someone other than the
actual user tries to reset the network, SecureLogin triggers the passphrase question. The user must
provide the correct answer before successfully logging in.

Even an administrator cannot access the user’s single sign-on-enabled applications without knowing
the user’s passphrase answer.

1 Right-click the SecureLogin icon in the notification area, then select Advanced > Change
Passphrase. The Passphrase dialog box is displayed.

¥ Securelogin

“ Novell .
T Securelogin,

Mame your place of bith

QK | Cancel

2 Specify the existing passphrase response in the field.
3 Click OK. The Passphrase Setup dialog box is displayed.
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Passphrase Setup

“ Novell .
Y Securelogin,

If you need to access your single sign-on details when you are not connected
to the network ar if your password is ever reset, SecureLogin will ask you a
passphrase guestion. You must then enter your passphrase answer.

1. Select or enter & passphrase guestion.
2. Enter and confirm a passphrase answer.

Enter an obscure answer so that no one is likely to guess it.

Enter a question:

Enter the answer:

Confirm the answer:

|
|

4 In the Enter a question field, select or specify a passphrase question.
5 In the Enter the answer field, specify the new passphrase answer.
6 Inthe Confirm the answer field, retype the new passphrase answer.
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Passphrase Setup

“ Novell .
Y Securelogin,

If you need to access your single sign-on details when you are not connected
to the network ar if your password is ever reset, SecureLogin will ask you a
passphrase guestion. You must then enter your passphrase answer.

1. Select or enter & passphrase guestion.
2. Enter and confirm a passphrase answer.

Enter an obscure answer so that no one is likely to guess it.

Enter a question:
Wha is your favorite poet? ﬂ

Who is your faverite poet?

Enter the answer:

Confirm the answer:

[Foereert

corcs

7 Click OK. The changes are saved.

NOTE: If you do not have access to the SecureLogin icon in the notification area, you cannot
change your passphrase answer. You administrator has disabled access to the SecurelLogin icon in
the notification area.
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